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Introduction 
 
HTS500 is an application created for Windows NT 6.0 and Windows platforms, which can 
manage the printing of supports for cables, terminal blocks, remote control switches, 
cabinets… 
This guide provide the knowledge regarding the operating logic of this powerful tool, and to 
reach a quick and satisfactory employment level. 
The added value of this system is inherent to the User’s Graphic Interface, which allows using 
the application with the maximum simplicity and the speed when creating the required output, 
as well as its capacity of structuring and standardizing all repetitive activities. 
 
HTS500 is available in English and French. The first time that the programme is activated it is 
possible to set the desired language by choosing the corresponding flag. However, further on it 
will be possible to change the language directly from the Tool Menu. 
 
The User guide is divided as follows: 
 
Terminology and Operation Requirements  
How it looks and the program functions  
Tools available for the job management  
Creation of a new job   
Tools available for the Custom’s articles management  
Prints  
Step-by-step instructions. 

 
The first section introduce some terms and concepts regarding the programme utilization 
 
The second section describes the job window 
 
The third and fourth sections explain in details the programme functionality for the job creation 
 
The fifth section focuses on customization articles 
 
The sixth section focuses on all aspects related to the print of the created jobs 
 
The seventh section gives an example of step-by-step instructions for the creation of a mono-
article job and a customized article. 
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1 – TERMINOLOGY AND OPERATION REQUIREMENTS  
 
1.1 - Terminology 
For clarification purposes we will provide a brief description of some of the terms which will be 
extensively used in the program and in the user guide. 
Job  = The whole data associated with the specifications to be transferred to the plotter. 
 
Family  = The whole Articles presenting similar specifications. 
 
Article  = Article from the ABB catalogue. 
 
Tag = Writing space 
 
Example  of tag types in the Matrix /Flags 

 
Head One: Matrix/Flag main heading  
Head Two: Matrix /Flag secondary heading 
Marker: allows the identification of cables, switches, terminals, remote control switches etc.  
Reference: allows the assignment of an identification value to the initials  
Tail: progressive numbering of the Matrix /Flag 
 
Matrix/Flag  = Predefined article composed of items placed on the right and left side (and/or 
only on one side) of the support 
 
Name-plate   = Article for the identification of external/internal push-button panel lamps  
 
Strip  = Article for the identification of modular components of external panel, switches, 
differentials etc. 
 
Lay-out  = Graphic representation of the article mounted on the print support (plotter plate).  
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1.2 - Operation requirements 
 
This program complies with all standards of Windows applications, such as: icons, function 
activation/inactivation, tool-tips, menu short-cuts, etc.  
 
In order to speed up work, the main HTS500 functions can be activated through buttons and 
icons present in the tool bar, but some functions can be accessed only through the Menus. 
The icons are normally self-explanatory of the functions they perform but, when in doubt, it is 
sufficient to position the arrow on the desired button to display the function description in the 
tool tip as well as in the lower program window. 
 

 
 
Normally, to go from one field to another of a window, use the “Tab” button, whereas the 
“Enter” button, according to a given context, may take on particular functions. 
The "Ctrl " and "Shift " buttons may be used for multiple selections. 
 
Notice :  
- Whenever a button is grey shaded , this means that the function is not available at that 

moment. 
- Some buttons stay pressed  (they are not in relief): this indicates that the related function 

is active. The inactivation of the function takes place by pressing the button again or, as in 
the case of exclusion buttons (e. g. text alignment) by pressing any other button.  

 
HTS500 is available in Italian, English, French, German and Spanish. The first time the 
programme is activated it is possible to set the desired language by choosing the 
corresponding flag. However, further on it will be possible to change the language directly from 
the Tool Menu. 
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2 – HOW IT LOOKS AND PROGRAMME FUNCTIONS  
 
2.1 - How the program looks 
 
The programme main window, as for most of the Windows applications, consists in two 
different areas. 
Opening the programme we find ordered from the top: 
• The menus 
• The Tool bar 
 

 
 
In the Tool bar, the programme shows a set of buttons/icons that allow direct access to the 
programme main functions, which can also be activated from various menus. 
 
Only the main or most used functions are represented in the Tool bar. Some functions can be 
activated only through the corresponding Menu option. 
 
The only active buttons are those relative to the creation of a new job and to the opening of a 
job already existing. 
 
When you open an existing job or create a new one the programme shows: 
 
1. The work window or the plate Lay-out with the graphic representation of the articles (if the 

plate dimensions exceed those of the window, the scroll bars will be displayed)            
2. the Window of Generator of data 
3. The Property window 
4. The Preview window 
 

 

2 
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2.2 - Menu 
 
 
Most of the HTS500 programme functions are at the user’s disposal directly from the Tool bar, 
but some functions are available only through the menus. 
 
The menu features present in the HTS500 are: 
 File 
 Edit 
 Tools 
 Help 
 
 
3 – TOOLS AVAILABLE FOR THE JOB MANAGEMENT 
 
3.1 - File Menu  
 
The FILE menu contains the following options: 
New Job : It creates a new job that can be as follow:  
• Mono-article  = The whole plate is composed of the same articles.  
• Bi-article  = Two different articles are placed on the plate (the first article is placed on the first 

line and the second one on the second line). 
• Multi-article  = On the plate are placed different articles and the user will decide their 

position.  
Open job : It opens an existing job. 
Save job : It saves the current job. 
Save job as : It saves the current job and allows to assign a name.  
Close job : It closes the current job and may perform the save function.  
Set printer : this function establishes which printer will be used as default by the HTS500 
programme, and to set its properties. Please, notice that the settings here defined will not affect 
the other Windows applications.  
Set plotter : this function establishes which plotter will be used as default by the HTS500 
programme, and to set its properties. Please, notice that the settings here defined will not affect 
the other Windows applications.  
Print job : It actives the print window for the selected job. 
Show print queue : It actives the window relative to the print queue. 
Exit : It closes the programme. 
Job list : It displays the list of the last opened jobs. 
 
 

3.1.1 Open job 
 
The option “Open job”, which can be activated from the “File” Menu or through the relative 
Icon/Button, allows to open a job previously saved for the checking and/or modification 
purposes. 
When you have chosen such option, the Path and the Job Name must be stated in the window. 
 

Press the browse button  to position on the folder (Directory) used to save the Job and 
select the name given to the Job (File).  
 
By pressing the “Open” button or double clicking on the name, the Path and job Name are 
displayed in the open Job window. The possible notes can be shown if the user has inserted 
them while saving the job and also the list of the used Articles can be shown as well. 
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3.1.2 Open job (*.csv) 

 
The file with the extension  (.csv) is a file  Ascii which has the following columns . 
For instance it is possible to create a file with  Excel  and  utilize the function ‘Save file as’ and the file CSV (which 
is separated from the index separator ). 
A File Ascii with separator has been created (‘;’) at the end of every single columns . The specifications of the  file 
CSV are standard, so we will not explain these specifications  in this  document. 
 
The informations that have been saved are: 
 
Informations Mandatory Default 
Group Yes  
Head 1 Yes  
Head 2 Yes  
Reference Yes  
Repetition Yes  
Tag marker  Yes  
Item codification yes  
Millimetres No  
Octal/Decimal No D’O’H decimal, octale, 

hexadecimal 
 

 
3.1.3 Save job 

 
The option “Save Job” can be recalled at any time through the entry in the File Menu, or with 
the button in the tool bar. It is also activated automatically when Closing the Job. 
There are two saving procedures according to whether it is a New Job or a Job previously 
saved. 
In the first case the user will be asked to specify the Job name and the Path. 
Usually it is suggested to save the job in the Project sub-directory of the programme directory.  
By pressing the browse button  it is possible to modify the Path and the Job name (file). 
Since the name given to the Job is usually short, the programme allows, in the space relative to 
the User’s Notes, to add extra useful information to identify the Job, according to the User’s 
needs.  
 
In the case of a job already saved, it is possible to save the changes by using the Save option 

or pressing the relative button in the Tool bar  
 
Notice : The “Save as” function may also be used to save a previous Job under a different 
name. This option is useful if, creating a new job, it is only necessary do small changes to a job 
already existing and previously saved. Or simply if you want to change the name to a job 
previously saved. 
 
Notice: The HTS500 during the job saving utilize an optimization management. This internal 
function allows having more physical space in the Hard Disk. For example the Export/Import 
function manages the same image utilized in more jobs just once. This management implies 
the job saving in different files with different extensions: 
.ggn:  data files 
.glv:  files with graphic information   
 
To manage correctly the single job it is advisable to use the HTS500 proper function (Save job, 
Save job as, Export job, Import job). In the case that a single file of the job will be re-
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nominated, moved, deleted, copied the entire job can be lost. 
For example: 
1. I create a job using any kind of article, inserting some data and calling it “Test” with the 

“Save Job” function. 
2. I select the Test.ggn  file and move it in another folder. 
3. When I will try to re-open the job with the HTS500, the system will signal an error and will 

not be able to open it again. 
 
 

3.1.4 Save Job (*.csv) 
 

This option saves the opened job with the extension (*.csv) according to the specifications of 
HTS500 for the management  of the projects. 

 
The information that has been saved is: 
 
Information Mandatory Default 
Group Yes  
Head 1 Yes  
Head 2 Yes  
Reference Yes  
Repetitions Yes  
Tag marker Yes  
Item Codification  Yes  
Millimetres No  
Octal/Decimal No D’O’H decimale, ottale, 

esadecimale 

 
The data have been saved as “generated” even if they have been inserted with the generator. 
 

 
3.1.5 Job Order 

 
The “job order” allows putting together a series of job created with the HTS500Hip. 
 
In the same “Job Order” it is possible to Open, Save and Copy more Jobs together. 
 
 
Save job order as : If you open a certain number of jobs and you select “Save job order as”, 
you would have the window for the Job Order definition: 
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All the Jobs opened in that time will be part of the job order. 
When you create new jobs that are not already saved, if you use the “Save job order as” option 
it will be asked you to save before the new jobs. This force the user to act in a certain order 
and to prevent that the job order is connected to jobs with non names, for ex.New_Job_1, 
New_Job_2, etc.. 
The default directory for the job orders saving is the same of the projects. 
 
 
Open job order : If you open a Job Order all the files connected to the Job Order will be 
loaded.  
Also all the jobs actually opened will be automatically closed, this to avoid that the jobs can be 
mixed accidentally. If you open a Job Order and one or more jobs are not available this is 
signalled with a message for each job not existing. 
 
Save job order : If you save the Job Order while using it, all the opened jobs will be assigned to 
Job Order. 
 
Close job order : If you close the Job Order while using it, all the Job Order files will be closed. 
 
 
 
3.2 - Edit Menu  
 
 
Cut : It copies the selected item/s in the annotations and at the same time erases the item/s 
contents.              
Copy  : It copies the selected item/s in the job window of the Windows annotations.              
Paste : It pastes the item/s, previously copied in the annotations inside the work sheet, starting 
from the selected item. 
Paste also properties : If the item/s copied are labelled, it/they keep the properties defined for 
it/them in the Property window, otherwise they will acquire the properties of the item/s to which 
it/they are pasted on to. 
Find/replace : it allows finding and/or substituting text inside the item/s containing markers that 
belong to the open job. 
Select all : It selects all the items of the open job. 
Select by group : Selects all the items (markers type) that belong to one or more groups. The 
belonging of an item to a group is defined at the time of insertion or modification of data in the 
generator window. 
Select special:  It allows doing selections inside a selection. 
Select complete : When this function is activated there is no distinction among the various 
types of items. In any case, it is possible to select markers, references, heads etc, present in 
the open job. 
Select by type : With this function it is possible to select only items of the same type  (e.g.: only 
heads, only markers, only references etc.), present in the open job. 
Reverse order : It reverses the order of the items selected of Markers type. Even if the 
Reference is not selected, it follows the markers. 
 

3.2.1 Selection 
 
HTS500 allows single and multiple selections.   
 
To select a single item it is sufficient a mouse click on the item represented in the Lay-out. 
Please, notice that the selected item becomes Green, and the contents is displayed in the 
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property window. 
Click on an empty area to cancel the selection. 
Multiple selections are ONLY possible by using the Ctrl and Shift keys together with the 
mouse. If you select an item only by clicking the mouse you go back to single selection. 
In particular: 
Sequential multiple selections: keep the Shift  key pressed and click with the mouse on the 
item from which the selection must start. Then, without releasing the Shift button, click with the 
mouse on the desired item that ends the selection. 
Non sequential multiple selection: keep the Ctrl  key pressed and click with the mouse on all  
the items under selection. 
Adding a single selection to a selection: keep the Ctrl  key pressed and click with the mouse 
on the item you want to add to the selection. 
Adding a sequential multiple selection to a selecti on: keep the Ctrl  key pressed and click 
with the mouse on the item designated as the start of sequential selection, then press the Shift  
key and select the item that ends the selection with a mouse click.  
 

3.2.2 Special selection 
 
 
The Special selection function allows selections inside a selection.  
It is possible to select several items or everything through the menu. 
 
You then proceed by selecting only: 
 
Even tags: selects all tags with even numbers 
Odd tags: selects all tags with odd numbers 
Right tags: selects all tags on the right side in the support 
Left tags: selects all tags on the left side in the support 
Even supports: selects all supports with even numbers 
Odd supports: selects all supports with odd numbers 
Select from the first: selects all tags between the origin and the current position 
Select up to the last: selects all tags between the current position and the last item available 
 
Notice: special attention must be put when using these special selections  
 
If the programme is required to select all Even items and subsequently all Odd items, the final 
logical result is that no tag will be selected, as it is not possible to select any Odd tags among 
the Even tags. 
Therefore, if after having selected all the Even tags you want to select all the Odd ones, it will 
be necessary to select all the tags. 

 
 
3.3 - Tools Menu 
 
Language: 

English: sets the language of the current session in English 
French: sets the language of the current session in French 
 

Printer centring:  printer initial centring function  
Plotter centring:  plotter initial centring function  
ASCII File Conversion:  imports files in ASCII format generated with other applications 
Import Job:  allows to import a job previously saved. A window, where the user must select the 
Job to be imported, is activated and, in the following window, indicate where the job must be 
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copied. 
Export Job: allows to export a job previously saved. A window, where the user must select the 
Job to be exported, is activated and, in the following window, indicate where the job must be 
copied. 
 
Customized Article: It actives the management function for customized articles. 
Erase customized article: It erases a customized article previously created. 
 
Configuration:   It actives the set configuration window  
 
 

3.3.1 Thermal Printer centring 
 
The centring  allows to makes some corrections at the print start point. The coordinates (x,y) can be modified for the moving 
of the starting point on right, left, to the top, at the bottom. 
 
10.1) Run the HTS500 
10.2) Select ‘File’,  Select ‘Plotter Setup’ 
10.3) Select the centring button (the second of the three buttons for each device)  
10.4) Flag the ‘Thermal transfer Printer’  function to allows at the HTS500 the activation of all the particular functions 
dedicated to the HTP500 printer. 
 
It is possible make corrections on the starting position inserting a relative value express with a hundredth of millimetre 
precision. 
 
To move the print starting: 
 
At the top Type in a positive value for the Y axis  
At the bottom Type in a negative value for the Y axis 
On right Type in a positive value for the X axis 
On left Type in a negative value for the X axis 
 
 
 
 
 
To verify the print starting position it is possible utilize any available item and compatible with the selected device. 
 
10.4) Create a single-item job inserting as text ‘HHHHHH’ in the first tag. 
10,5) Print the job 
10.6) Verify the centring of the first tag. 
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10.7) a) Example: text too high : makes a correction to the bottom (-Y) 
 
 
 
10.8) b) Example: text too low : makes a correction to the top (+Y) 
 
 
 
10.9) c) Example: text shift on right : makes a correction on left (-X) 
 
 
 
10.10) d) Example: text shift on left:  makes a correction on right (+X) 
 
 
 
Notice. 
This operation (10.1, 10.10) should be done once for all the prints devices with any kind of items on those at disposal for the 
device. 
 

3.3.2) Calibration of the length of printing text 
 
The calibration allows to make some correction on the print step length.  
For each device of laser or thermal printer type it is possible to give a unique correction value, positive (extend the step) or 
negative (shorten the step) utilizing any kind of item at disposal. 
 
Look at a calibration example of the Horizontal axis with the PPB2715 item. 
 
11.1) Run the HTS500 
11.2) Create a single-item job 
11.3) Insert some texts (HHHHHH) for all the item tags. 
11.4) Verify the centring of the first and the last tag 
11.5) If the print is too short: 
 
    first left tag                                                                           last right tag 
 
 
        
         d1                                                                                    d2 
 
 the print step should be extended. 
         11.5.1) Measure of how many mm the print step is shorter (for example 3 mm). To obtain the difference, the d1 distance 
between the left item edge and the first ‘H’ of the first tag will be measured, and also will be measured the d2 distance 
between the left edge item and the first ‘H’ of the last tag; so the difference will be: d1-d2=3mm 
 
11.6) Select ‘File’,  Select ‘Plotter Setup’ 
11.7) Select the centring button (the second of the three buttons for each device):1 
11.8.1) In the window on the left bottom side there is the calibration part: 
Select for the X axis the PPB2715 reference item 
After the item description in the parentheses there is the reference measure of the printed area (220 mm): 
In the X field type in the value in millimetre  of the print step really printed. 
In our example: if the PPB2715 is the selected one, the print area is 220 mm 
If the printer prints 3 mm shorter, insert in the X field the value 220-3= 217 mm. 
HTS500 makes a correction for each print of 217 mm and expand it at 220 mm. 
This correction value works for all the items of that device. 
 
 
 

HHHHHH 

HHHHHH 

HHHHHH 

HHHHHH 

HHHHHH HHHHHH 
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Look at a calibration example of the Vertical axis with the WMTT12  item for the Feeder. 
 
12.1) Run the HTS500 
12.2) Create a Single-item job 
12.3) Insert some texts (HHHHHH) for all the item tags. 
12.4) Verify the centring of the first and last tag 
12.5) If the print is too short: 
 
    first top tag                                                                           last bottom tag  
 
 
 
       d 
 
the print step should be extended. 
         12.5.1) Measure of how many mm the print step is shorter (for example 3 mm). To obtain the difference, the d1 distance 
between the left item edge and the first ‘H’ of the first tag will be measured, and also will be measured the d2 distance 
between the left edge item and the first ‘H’ of the last tag; so the difference will be: d1-d2=3mm 
 
12.6) Select ‘File’,  Select  ‘Plotter Setup’ 
12.7) Select the centring button (the second of the three buttons for each device): 
12.8) In the window on the left bottom side there is the calibration part: 

12.8.1 Select for the Y axis the WMTT12 reference item 
12.8.2 After the item description in the parentheses there is the reference measure of the printed area (85 mm). 
12.8.3 In the Y field type in the value in millimetre of the print step really printed. 
12.8.4 In our example: if the WMTT12 is the selected one, the print area is 85 mm 
12.8.5 If the printer prints 3 mm shorter, insert in the Y field the value 85-3=82 mm 
12.8.6 HTS500 makes a correction for each print of 82 mm and expand it at 85 mm. 

 
This correction value works for all the items of that device. 
 

 
3.3.4 ASCII File Conversion 

 
HTS500 allows the automatic import of data generated by the most popular applications, such 
as Spak, Elecad, CADelet, Eplan, etc. 
These types of software, created for the development of electrical systems and for general 
electrical system planning, allow  to export the “initials” in a file in ASCII format.  
The files, in order to be used by the HTS500, must respect all the conditions imposed by the 
Record Tracing. 
 
Not all the times is possible to have a file that respects the required Record Tracing. In this 
case, the HTS500, through the ASCII file conversion function available on the Tool menu, 
permits the transformation in the required format. 
After having selected the file to be imported and having confirmed the choice with the Open  
button, the ASCII file conversion window will be displayed on the screen. 
Let’s see in detail this new job window. 
 
reads :  it points out path and name of the selected file 
writes :  it requires the input of the name of the incoming file, that is the one obtained after the 
conversion. Press the Browse button  
head record present : if it is activated, the head record will be ignored, that is the first starting 
file line.  
Erase markers = empty field :  with this option activated during the conversion all the empty 
markers fields will be deleted. 
Markers to import : the two IN – OUT fields require numeric values corresponding to the initial 
and final position, in terms of number of characters from the left, relative to the part of the origin 
file line to be associated with the field markers. 
Acquires Head1: its activation allows to specify, in the same way as described for the markers 

 
HHHHHH 

HHHHHH 
D1 D2 
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field to import, the values for Head1. 
Acquires Head2: see Acquires Head1 
Acquires Group: as above referring to the group to be associated to the marker. 
Acquires Repetition Nr: number of repetitions associated to the marker 
 
Any set statement may be saved through the “Save” function, and be subsequently activated 
by means of “Reads” anytime that the starting file has the same tracing specification. 

 
 

3.3.5 Record tracing for direct import 

 
 

Notice: The presence of two  characters (double characters ASCII Alt+124) in the marker 
field are interpreted by the programme as an “enter” for the management of a multi-line text. 
 

3.3.6 Configuration (Font Precision and Multiplotter) 
 
The programme usually signals whether the text can be completely contained in the item area 
by colouring the background in red whenever the text is too large (otherwise it would look 
incomplete). 
 
The programme considers the text area by including a blank space above the capital letters, 
which is usually reserved to indicate accentuated capital letters and a space below the 
character, for the print of descending characters (e.g. p etc.) 
For this reason is possible to obtain the signalling relative to the exceeding text even for text 
that are inside the item, and so is possible to set the programme to reduce the error indication 
percentage. 
In the open window it is possible to state a value that virtually increases the item height and 
width. 
 
The programme approximates the curves utilized to draw the characters with straight lines. In 
the “Print font precision” field it is possible to indicate the number of straight lines for each 
curve. To consider that the higher is the number stated, the more are the values sent to the 
print and so the more precise is the print. 
Generally: for small fonts it is suggested to decrease such value, and increase it for bigger 
ones. 
 
Multiplotter  management option is activated when multiplotter installation is needed. This 
option allows to set and work with more than one plotter at the same time. 
 
For the Thermal Printer management is necessary to activate the Multiplotter  option. 
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3.3.7 Adjustment for HTP500 

 
This option allows to modify the item print length for the HTP500 printer. The correction will 
work on the dimension in length of the item. The number in millimetres can be positive or 
negative and is possible to use a correction of two decimal number. 
 

3.3.8 Job analysis 
 
The programme can elaborate calculations to determinate the number of used tags utilized in 
the saved job, and in particular it scans the Windows folders’ content that contain the HTS500 
jobs producing a report that indicates: 
� in each folder the jobs present, the used articles and the number of written tags. 
� the total summary by article, with the number of used articles and the number of written 

tags. 
 
For example, let’s consider a folder structure identified by a code as follows: 
 
The folder “test1” contains the sub-folders “test11”, “test12”.   
The folder “test11” contains the sub-folders “test111”, “test112”.  
The folder “test12” contains the sub-folders “test121”, “test122”. 
 
Each folder contains the same job with the SIHF2W/15 article used 5 times for a total of 100 
tags. 
 
 
The following table shows an example of a job analysis calculation: 
 

Actual Analysis Folders and sub-folders 
Number 

of Articles 
Number 
of Items 

Number 
of Articles 

Number 
of Items 

Test1   5 100 35 700 
 Test11  5 100 15 300 
  Test111 5 100 5 100 
  Test112 5 100 5 100 
 Test12 Test121 5 100 15 300 
  Test121 5 100 5 100 
  Test121 5 100 5 100 
 
In the “Actual” columns are reported the values present (5 articles, 100 tags) for each job 
and that are the same for each folder. 
In the “Analysis” columns are reported the values calculated during the elaboration and 
by selecting as starting folder the one of the line. For example: 
 
If you elaborate the content of the “test11” folder, the values for the articles (5 of “test11”, 
5 of “test111”, 5 of “test112” for a total of 15) and the values for the tags (100 of “test11”, 
100 of “test111”, 100 of “test112” for a total of 300) are added. 
 
If you elaborate the content of the “test1” folder all the values of the articles present in the 
structure are added, for a total of 35 articles with 700 tags. 
 
To do the job analysis selects “Job Analysis” voice from the tool menu. The window “Job 
analysis management” appears. 
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Let’s see in detail this new job window: 
 
The tool bar permits to:  
Select between computer and web resources 
Go back of one level to a previous folder  
To display the big icons 
To display the small icons 
To display the list 
To display file details 
 
It is possible with the mouse to select a job or a folder respect which do the job analysis. 
 
Analyzes: it permits to run the elaboration starting from the selected job or folder. 
Closes: it closes the job window. 
 
The processing result appears on the screen in a file that may be saved in text format (txt), by using the 
Windows “Note Book”. 
 
 
 
 

3.3.9 Configuration 
 
Signalling sensitivity to overflow value in Percent : It allows to correct the system sensitivity 
of the overflow signalling in the case that on the screen it is signalled an overflow that in reality 
doesn’t exist. (This imprecision might be caused from particular video controller). 
 
Font accuracy of print in course :  It allows to improve the quality and the definition of the 
vectorial lines in the font writing for the Plotter. The default value is 2, it is possible to increase 
the precision using particular output for particular applications. (see images drawing for logos). 
 
MultiPlotter Management : It allows to manage contemporary 10 different drivers. It is possible 
to set the configurations for the different Plotters, Laser printers and Thermal printers. 
 
Default folder for jobs saving: It allows to assign a default value for the jobs saving. 
 
Generator: Use advanced functions: It allows to flag the option to work with the new 
generator that uses the Excel-Like format. 

 
Automatically open the new Generator grid:  To set the utilization of the new generator as 
predefined when creating a new job. 
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3.4 - Tool bar - Job 
 

 
 

 Creates a new job of mono-article type 

 Opens a job previously created            

 Saves the current job  

 Closes the current job and may activate the save procedure  

 Copies in the annotations the selected items while erasing the item contents  

 Copies the selected items present on the job window in the Windows annotations  

 Pastes previously copied items in the annotations inside the work page starting from the 
selected item   

 Find/Replace allows to find and/or substitute text inside items containing markers related to 
the active job  

 Shows/hides the generator window    

 Shows/hides the property window 

 Activates the print manager window  

 Activates the tail print manager window  

 Allow to respectively zoom out and zoom in the image of the plate on the screen by 
10%  

 It allows to enlarge a selected plate area. After pressing the relative icon/button, position 
the mouse cursor in the starting point of the area to be enlarged, and form a rectangle by 
pressing the mouse left key. Once the desired dimension has been reached, release the 
mouse key to obtain the enlargement. 

 It allows to set the Zoom factor of the job window. It may be set directly in the field or 
chosen from the displayed list by pressing the arrow on the side.  

 Returns to the preceding Zoom 

 The activation of various Zoom functions is done by pressing the arrow (here bordered 
in red) . They are:  
Width Zoom = It sizes the Lay-out window to the width of the application window  
All plate Zoom = It shows the whole plate in the application window 
Align plates to current Zoom = It sets the same Zoom factor of the selected plate for all 
plates that belong to the job 
Standard  Zoom = It sets the Zoom factor to the standard value  
Go to origin  = It moves the Lay-out in order to show the first item in the upper left corner  

Shows the current job and the name given during the saving. If 
there are more jobs open at the same time it is possible to go from one to another by selecting 
them from the list, which can be displayed by pressing the arrow next to the job name.  

 It activates the Help 
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3.5 - Property Window 
 
The Property window may be used to insert data directly in the tags or to change their 
contents. 
If the tag contains numeric and/or alphanumeric progressions created automatically by 
the Generator, the changes here made are transferred to the Generator. So if a new 
“Run” of the Generator will be activated the changes will be kept.  
 
In this window are defined the text and picture features which will be inserted and later on 
printed on the tag.  
You move in the different window fields with the "TAB" key, whereas the “Enter” key 
allows to go to the next tag. 
 

 
 
In the above part are shown the selected tag coordinates under work. The picture shows 
the Matrix and Marker number.  
The settings are different depending if it is a Text or a Picture. 
In the lower part is displayed the selected tag, enclosed in a red border and here is 
shown a preview of the final result. Please, notice that all settings are reported 
simultaneously on the Lay-out plate but, depending on the set zoom factor, it may be 
difficult a clear vision of the item contents. 
 
To go to the next tag press the “Confirm”  button. This is the same as pressing the 
“Enter” key. 
 

 These two buttons are active for fields of text type, and allow to:  
- the first on the left, to memorize all the tag specifications on file. 
- the second on the right, to restore the original values. 
It may be memorized different specifications for the tags of type Marker, Head1 and Head2, Reference and 
Tail. 

TAGS 
COORDINATES 
(see Module n. 
001 Tag Number 

TEXT 
PROPERTIES 

EDIT AREA 

PREVIEW OF 
WORKING 
SELECTED TAG 
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The next time that article will be used, the fields will be already set with those values.  
 

3.5.1 Text property window – Job  
 

 
 
The settings that can be defined for a text are in the following order: 
• Horizontal alignment (left, centre, right) 
• Vertical alignment (top, centre, bottom)  
• Vertical writing. When activated the text insert in the tag or in the lower portion, if it is a 

custom made article, will be written vertically.  
• Automatic reduction of the font height with the minimum height option. When activated, 

if the text exceeds the tag or the lower portion dimension, if it is a custom made article, 
it will self re-sizes to fit in the tag or lower portion,  since when it will reach  the 
minimum settled dimension. 

• Font choice.  It is possible to select among all installed fonts.  
• Minimum height (presents only when the automatic reduction key is selected) 
• Character dimension in points (in  the tool tip is reported the height in mm .) 
• Character dimension in width (if 0 depends on the set font dimension) 
• Setting of character color 
• Fixed spacing between vertical lines: sets a fixed vertical space value (if 0 the spacing 

depends on the font dimension) 
• Fixed distance between characters: sets a fixed horizontal space value (if 0 the 

spacing depends on the font dimension) 
• Text rotation angle: sets the text rotation angle 
• Text style (normal, bold, Italic, bold/Italic) 
• Select special symbols: it allows the insertion of symbols inside a field 
 
Notice:  for a correct viewing it must be set as "ABB"  font. 
• Text : in this field must be insert the text that has to be printed on the tag. The "Ctrl " + 

"Enter " keys used in association permit to go to a new paragraph, and so to write text 
on more lines.  

 
By selecting Picture you may insert a picture instead of a text.  
Pressing the Borders  button it is possible to give to a tag or to a lower portion a border (if 
it is a custom made article).  
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3.5.2 Borders 
 
By pressing the Borders button it will be display a window in which it is possible to 
establish which border sides are going to be shown (by selecting with the mouse the 
sides to be displayed or using the All/None buttons) the color and the thickness.  
 

 
 
In the same window it is possible to define margins (left, right, top, bottom) for the 
position of the tag content in the desired place. 

 
3.5.3 Picture property window – Job 

 

 
 
The picture formats  used by HTS500 are:  
• .Gif  
• .Jpg  
• .Jpeg  
• .Bmp  
• .Wmf 
 
Notice:   Only the printer can use the above formats, while the plotter can prints only in 
.Wmf format . 
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By selecting the “Picture” option in the property window, the programme asks to indicate 
the file name of the picture that has to be inserted in the tag, or to look for it on the hard 
disk.  
When a picture file is selected, the picture is displayed in the search window; it will be 
sufficient to press the “Open” button (or double click on the file name) to insert the picture 
inside the field. 
It is possible to change the picture later on, pressing the “Browse” button. 
The user can: 
• Move the image inside the field  for a better centring by changing the values “Left” 

and “Top”. In particular increasing the “Left” margin value the image will move to the 
right, while decreasing it the image will move to the left (negative values are also 
accepted). In the same way, increasing the “Top” value the image will move to the 
bottom and increasing it will move to the top. 

• Change the picture dimensions  in height and width (by changing the “height” and 
the “Width” values). 

• Lock the picture dimensions to the field. In this case the picture will be deformed to fill 
the whole field.   

• Flip the picture horizontally. 
• Flip the picture vertically. 
 
Notice: selecting again “Text”, the picture is erased and the original text settings are 
restored.   
 
 

3.5.4 Bar Code property window 
 
The bar code format managed by the HTS500 are: 
 
- EAN 8: 
- EAN 13: 
- UPC/A: 
- UPC/E: 
- EAN UCC 128: 
- CODICE 39 (Normal): 
- CODICE 39 (Full Ashii): 
- CODICE 93: 
- CODICE 128: 
- CODICE 32: 
- INTERLEAVE 2/5: 
- CODABAR: 
- PDF417 (Bidimensionale): 
 
It is possible to create personalized formats and save them with a name. 
 
The saved file with the bar code format can be assigned as property at the single tag. 
 
3.6 - Window Generator 
 
The window Generator permits the automatic creation of numeric sequential, alphabetic 
and mixed  strings. 
When creating a new mono-article, bi-article or multi-article job, a new article plate is shown, and in the 
lower part of the HTS500 window is displayed the Generator window. 
It looks as a table containing all the information necessary for the sequential generation, 
based on two gaps.  



 
  

                                                                                    24 
  HTS500 Software user guide - 1SNC160011M0201-V2 

 

In particular: 
- start : number and/or letter from which the generation starts     
- arrival : arrival number and/or letter where the generation ends  
- repetitions : number of times the marker must be repeated  
- step : increase or decrease value 
- group : possible group of belonging. 
- head 1 : possible text to be inserted in "Text 1" of the article 
- head 2 : possible text to be inserted in "Text 2" of the article 
- 8-10-16: indicates the numbering type (Octal, Decimal or Esa-decimal) 
 
The table columns dimensions may be changed according to one’s needs using the 
mouse on the separating line between the columns. This allows a satisfactory vision of 
the data. 
The active record is displayed in Blue color.  
 
All generator functions are grouped in the right side of the window, in an area that can be 
defined as Generator Functional Buttons and allows to create, change, erase the 
generator lines, import ASCII files and files created with HTS50098. 
 
 
Notice: Every data creation or change done with the Generator will also change the Lay-out. At the 
same time, every direct change made on the Lay-out, utilizing t he Property window, will modify the 
generator. 
 
Pressing the “Run” button it actives the creation of the set sequences. The result will be 
transferred immediately on the Lay-out. 
When the set sequence/s generate more sequences than the tags present on the plate, 
the programme adds new job plates. 
 

 
3.6.1 Generator functional pushbuttons 

 

 
 
Imp. Txt : HTS500 allows the automatic import of data generated by the most popular 
applications of software, created for the development of electrical systems and for general 
electrical system schedule. This data, exported in an ASCII file format, are automatically 
imported in the HTS500, permitting a big saving time and the elimination of typing errors. Just 
select the desired *.txt  file format and pressing Enter , the HTS500 will automatically import the 
file if the Record Tracing is followed.  
Imp. Gen.:  allows to import .gen  (generated with HTS50098) and .ggn  files format (generated 
with HTS500) into the Generator. It allows to import into the Generator a job previously saved 
extracted from another Generator. This function allows to import markers and associated data 
to a determined article into another one that is different in nature and type.  
For instance: data entered for a cable support can be quickly transferred to a pin support, etc.  
New: It allows to create a new Generator line. 
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Enter : It allows to create a new Generator line before the active line.  
Delete : It allows to delete the Generator active line after having selected it with the mouse. 
Clear : It allows to delete all Generation lines created, practically delete all the Generator 
contents . 
Modify : It allows to modify a Generator line previously created. 
Run : It runs the information contained in the generator, developing so the alphanumeric 
sequences entered and displays the results achieved on the lay-out. 
On the top there are the Navigation arrows  that allows to move within the Generation lines for 
the selection of the desired record.  
From left to right there are:  
. Go to first line  
. Go to previous line  
. Go to next line  
. Go to last line  
Heading management:  usually is set on OFF. In this case the markers generated will be 
inserted sequentially in the tags, ignoring what shown in the fields Head 1 and Head 2. When it 
is ON it inserts the markers on the tags maintaining the matching with the headings. To do this 
the generator inserts empty tags until it will fills up the Matrix/Flag. It is possible to set afterward 
the heading management at ON and activate the running again to obtain the markers on the 
tags that keep the headings, but, because empty tags are inserted in the generator, you cannot 
get the inverted operation setting the heading management to OFF again. In this case it is 
necessary to change manually the generator, deleting the line that corresponds to the empty 
tags.  
Find start text : It allows quickly searching for strings existing in the Generator.  
 

3.6.2 Entering/Modifying data in the generator 
 
HTS500 has been developed with particular attention to simplifying entering and modifying the 
data to be used to generate the desired initials/markers.  
It  is possible to create a new Generator line, modify an existing one or enter a line between 2 
already existing. 
In the first case it uses the "New” button, in the second case the "Modify” button and in the 
third, after having highlighted the line before which you want to enter the new line, it uses the 
"Enter” button. Within the window where you enter and/or modify the data of each single record 
of the Generator, you move either with the mouse or with the TAB (Tabulator) key. 
 
The required data are, basically, the ones that appear in the generator grid, and in particular: 
Start : to indicate the marker from which the generation will start.  
Arrival : to indicate the marker from which the generation will arrive.  
Repeats : to indicate how many times the marker has to be repeated, before the increment or 
decrement, if it exists. Such value cannot be less than 1. Example: from A5  to B7 with Repeats 
= 2, it will generate: A5 A5 A6 A6 A7 A7 B5 B5 B6 B6 B7 B7 
Step : to indicate the increment or decrement value associated to the numerical progression. 
The alphabetical progression accepts only step = 1 while for the numerical progressions are 
also valid values less than 1, so can exists  decimal, or even centesimal, increments.  
Group : it is possible to assign a Group name to the markers that have been generated. This 
can be useful to make selections. This field is not mandatory.  
Decimal/Octal/Hex : states if numerical sequences have to be in a Decimal, Octal or 
Hexadecimal base. 
Heading 1 : the text here contained will be reported in the Matrix field named  Head 1. It is 
useful to recognize the Matrix and has no running purpose.  
Heading 2 : the text here contained will be reported in the Matrix field named  Head 2. It is 
useful to recognize the Matrix and has no running  purpose.  
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Reference : the text here contained will be reported in the field named Reference on the matrix 
stem. This field is not mandatory. 
 
About generation, we can have: 
 

 
3.6.3 Numerical progressions  

If you need to generate a numerical progression, you have to type the start number and the 
arrival number. If, for example, we want to obtain a progression from 1 to 10, we will have to 
enter the value 1 in the Start field, and the value 10 in the Arrival  field. 
After pressing the "Confirm" button the generator window will be updated and the indicated values will be found in 
the first line. Pressing the "Run" button we will have the generation on the layout. 
 
It is important to notice that the Start  dimensions do not affect the Arrival  dimensions: 1 is one 
character and 10 are two characters, but the input is anyway accepted as a valid one, in the 
same way as the 1 to 1000 generation is accepted or a 10 to 100 without the request to 
observe the equal dimensions in the variables. 
 
Of course an opposite numbering can be requested, such as 10 to 1 or 1234 to 20, with a 
negative setting of the Step field. For example from 10  to 1 the Step field must have the value 
–1.00. 
 
It is important to advice that even a request that is not mathematically correct can be accepted 
and run, such as 01 to 10 or 0001 to 1000. The programme will keep, or shift when needed, the 
leading zeroes. 
  
 

3.6.4 Alphabetic progressions 
If an alphabetic progression is needed, you have to indicate, in the Start field,  the letter of the 
alphabet from which you want to start the progression and, in the Arrival field, the end letter 
(Start: B – Arrival: F).  
Both upper and lower case letters are accepted.   
The alphabetic progression accepts only Step=1. 
 
After pressing the "Confirm" button, the generator window is updated and the indicated values 
will be found in the first line. By pressing the "Run" button we will have the generation on the 
layout. 
 
 
 
 
 
 
 
 
 
 

3.6.5 Mixed initials/markers 
 
Of course it exists the necessity to get markers that contain a fixed (constant)  part which is associated to a 
variable part.  
From A1 to A10, from A1 to F1, from b01 to b20, from V/100 to V/001 (negative Step), are 
some examples. All what has to be done is typing Start and Arrival into the respective fields, it 
is up to the programme to discriminate the variable part from the fixed part, independently on 
their order.  
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Are observed also the requests for spaces within the markers: e.g. from the marker A A to the 
marker A G, in the same way as markers keep on being valid where their constant and variable 
parts are both alpha parts , as it can be seen in the former example,  or their constant and 
variable parts are both numerical parts, as 1 01 to 1 10; the first request will give A A/A B/A  
C/A D/etc…as a result, the second 1 01/1 02/1 03/1 04…to /1 10. 
Are also accepted Markers with numbers or letters on two or more lines:  
A    A  
A   G 
It is important to remember that the consistency of the request is also managed and indicated, 
so illogical requests are hold and indicated, for example the a1 to A22 sequence, where both 
letters are not lower case or upper case letters, cannot be executed in any way. In this case it 
will not be possible to enter inconsistent data without receiving a fault indication.  

 
3.6.6 Double generation 

HTS500 allows to generate markers with a double mixed variable, either associated or not 
associated to constant parts. 
Always without a personal intervenes are processed requests such as: from A01 to B10, or 
from 22/C to 50/H, or from 15-10 to 20-20. Are possible also from 01ABC01 to 10ABC10, or 
from A123A to B123D, etc… 
The only condition to be always observed is the logic of the request. No other condition is set. 
Of course it is hard to list all possible combinations.  
 
 

3.6.7 Generator Data alignment  
 
The column heading that create the generator grid are alignment buttons: 
 
- If you press with the mouse the column heading of the grid, the software align the inserted 

data increasing them in alphabetic order. 
- When there is the same value in the aligned column the data are aligned for inserting order. 
- The columns in which is possible to make the data alignment are: 
- Starting 
- Arrival 
- Group 
- Head1 
- Head2 
 
 

3.6.8 Generator Data selection for Group 
 
It is possible to select the generator data for one or more inserted groups. 
 
- Open a job with some inserted data 
- From the Edit menu select “Select per Group ”. 
- On the screen there is now the selection window for Group. 
- On the left part there are all the groups created in the grid. 
- Select and highlight with the mouse the value for the Group from the list. 
- Press with the mouse the button with the right arrow, the highlighted value will move in the 

window of the highlighted values. 
- Press with the mouse the ok  button to confirm the selection. 
- All the values of the selected group rows will be highlighted. 
 

3.6.9 Generator Data selection for Head1 and Head2 
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It is possible to select the generator data for the inserted values of the Head1 and Head2. 
 
Here below it is showed how to select the data for the Head1 (the operations are the same for 
the Head2). 
 
- Open a job with some inserted data 
- From the Edit menu select “Select for Head1 ”. 
- On the screen there is now the selection window for Head1 and Head2. 
- On the left part there are all the Head1 values inserted in the grid. 
- Select and highlight with the mouse the value for the Head1 from the list. 
- Press with the mouse the button with the right arrow, the highlighted value will move in the 

window of the highlighted values. 
- Press with the mouse the ok  button to confirm the selection. 
- All the values of the selected group rows will be highlighted. 
 

3.6.10 Copy and paste Generator rows 
 
It is possible to copy the generator data from one job to another or in the same job. 
 
- Open a job with some inserted data 
- Select with the mouse and the control or shift buttons a whole data rows. 
- Select from the Edit menu “Copy data from the generator ”. 
- Create a new job with any kind of item. 
- Position the mouse on the grid of the generator data. 
- Select from the Edit menu “Paste data in the generator ”. 
- In the grid will be visualized the new records. 
Press the Run button. 
 
 
 
 
 
 
 
 
 
3.7 Generator Window in EXCEL-LIKE modality 
 
The Generator data in EXCEL-LIKE modality handle all the types of text data insertions utilizing 
an electronic sheet. 
 
 

3.7.1 To activate the functions of the New Generator: 
 

The new generator functions can be checked or not using the “Configuration” window in the 
HTS500HIP. 

 
Run the HTS500HIP. From the Tools  menu select the Configuration window. 

 
Two options are now available:  
Generator: use advanced functions :  To check the utilization of the new generator in Excel-
Like modality. 
Automatically open the new generator grid:  To set the utilization of the new generator as 
default when creating any new job. 
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3.7.2 To activate the Excel-Like generator data: 

After have created a New Job press the ‘Shows generator grid’ button from the principal tool 

bar menu. . 
 
 

3.7.3 Utilization of the electronic sheet 
 
It is like an electronic sheet containing the necessary information for the sequential generation, 
based on two intervals. 
In particular: 
- Start : number and/or letter from which the generation starts 
- Arrival : number and/or letter of generation arrival 
- Repeats : number of times that the marker should be repeated 
- Step : increasing or decreasing value  
- Group : eventual belonging group 
- Head1: eventual text to insert in the item "Head1" 
- Head2: eventual text to insert in the item "Head2" 
- D-O-H: indicate the numbering type (Decimal, Octal, Hexadecimal) 
- Generation Increase:  indicate the generation priority for Example from R1 to T2. The 

generation from LEFT to RIGHT create the sequence R1-S1-T1-R2-S2-T2, the generation 
from RIGHT to LEFT create the sequence R1-R2-R3-T1-T2-T3. 

- Swap:  in the case of double generation for Example from R1 to T2 create for each 
generated marker the reverse value: R1-1R-S1-1S-T1-1T-R2-2R-S2-2S-T2-2T. 

 
3.7.4 Generator functional Buttons 

 
Index of the available functional buttons: 
 

 
- New: Create a new job. 
- Load file : Open an existing job in XLS format. 
- Save: Save the current job 
 

 
- Cancel modification:  Cancel the latest modification in data-entry step. (F2 button). 
- Restore modification:  Restore the latest modification in data entry step. (F2 button). 
 

 
- Cut:   Cut the selected cells and rows. 
- Copy:  Copy the selected cells and rows. 
- Paste : Paste the selected cells and rows. 
- Find:  Open the window to make a data search in the electronic sheet. 
- Find / Substitute:  Open the window to make a data search / substitution in the electronic 

sheet. 
 

 
- Property Window : Open the electronic sheet property window. 
The first part of the window set the values that should be inserted in a new generator row 
coping them from the last row: 
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In particular each option mark the copy for the following values: 
Copy the Start  from the previous row; 
Copy the Arrival  from the previous row; 
Copy the Repeats  from the previous row; 
Copy the Step  from the previous row; 
Copy the Group  from the previous row; 
Copy the Head1 from the previous row; 
Copy the Head2 from the previous row; 
Copy the Reference  from the previous row; 
Copy the Dec/Ott/HEX  from the previous row; 
Copy the Direction  from the previous row; 
Copy the Swap  from the previous row; 
 
The second part of the window set the values that should be inserted in a new generator row. It 
is possible to assign the values for: 
Repeats :  It should be a numeric value higher then 0. 
Step :  It should be a numeric value higher then 0. 
Dec/Oct/Hex : It should be a value chosen between Dec, Oct, Hex. 
 
The third part of the window allows to define the option: 
Copy the contents of Start in Arrival :  This option is recommended in case it is needed to 
use the save function in an external file to avoid an empty column in the destination file. 
Use SmartClipboard : If checked it allows to activate the function of data self-insertion in the 
Excel-Like sheet. 
For Example: 

a) In Start write, first row, the number 1 
b) In Start write, second row, the number 2 
c) Select with the mouse the first cell and after the second using the Shift button, all the 

cells highlighted in the Start column will be filled with the numbering 3, 4, 5, 6 ecc. The 
new contents substitute the previous one. 

 

 
- Exit:  It go back to the HTS500 normal layout. 
 

3.7.5 Files management XLS format 
 
From the “File” menu it is possible to select the functions to manage the files in XLS format. 
 
New:  Clear the existing job and prepare the sheet for the creation of a new job. 
Load File :  It allows to Open an existing file in XLS format: 
The program load the XLS file. 
This file should respect the electronic sheet tracing: 

1) Column: Start  
2) Column: Arrival  
3) Column: Repeats  
4) Column: Step  
5) Column: Group  
6) Column: Head1 
7) Column: Head2 
8) Column: Reference  
9) Column: D for decimal, O for Octal, H for hexadecimal 
10) Column: Direction  N for Left to Right, Y for Right to Left 
11) Column: Swap : N per No, Y per Yes. 
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The columns are not all necessaries: it is sufficient an XLS file with just one column to insert 
the data in the Start filed. 
 
Save File : Save the data of the current Electronic Sheet in XLS format. 
Save File as:  Save the data of the current Electronic Sheet in XLS format. The generated file 
has the same composition of Job electronic sheet. 
 
 

3.7.6 Data validation when closing the electronic-sheet 
 
When you close the grid window a control on the data properties is done. If  there are in the 
rows errors regarding Start and Arrival it will be signaled with a message. 
 
Closing the window, in the rows you can find the generator Records. This Records substitute 
those that in origin were present and a generation is create. 
 
The rows with non valid data (highlighted with pink color) are ignored. 
 
 

3.7.7 Data Copy and Paste from other applications 
 
It is possible to Copy and Paste from other applications. 
To make a cells interval copy from an electronic sheet: 
- Run the Ms-Excel application; 
- Select with the mouse a cells continuos interval (keep press the SHIFT button and select 

with the mouse the cells interval); 
- Press the Control-C button (or CONTROL-INS); 
- Open the HTS500-HIP generator sheet; 
- Select with the mouse the first cell where to copy the interval; 
- Press the Control-V button to paste the data (or SHIFT-INS). 
 
 

3.7.8 Cancelling of cells or rows interval (CONTROL-DELETE button or SHIFT-DELETE button) 
 
It is possible to select an interval of rows from the generator electronic sheet and cancel all the 
selected rows. 
To cancel the rows interval: 
- Select with the mouse the rows interval from the electronic sheet (keep press the SHIFT 

button and select with the mouse the first and the last row of the interval to be cancelled); 
- Press CONTROL+DELETE to cancel all the rows of the selected interval; 
- It is possible to select the CELLS interval from the generator electronic sheet and cancel all 

the selected CELLS; 
- With the Shift-Canc buttons the rows doesn’t changes and it is cancelled just the content of 

the selected cells. The content is firstly copied into the clipboarb. 
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4 – Creating a new job 

 
4.1 - New job 
 
When a new job is created you can state if, on the whole plate will be mounted, the same 
article (Mono-article job), two different articles (Bi-article job) or more different articles (Multi-
article job).  
A new Mono-article job creation can be activated both by pressing the related pushbutton/icon 
and with the New Job option in the File menu, while for a Bi-article or a Multi-article job 
creation, it must be used the available option from the File menu.  
In particular:  
Mono-article job : The programme positions the article in order to use all the plate.  
Bi-article job : The programme positions the first article on the plate in the first line and the 
second article in the second line.  
Multi-article job : The user can build up a plate with a combination of articles that is absolutely 
free. Utilizing the mouse it can position any article in any free hole plate and the programme 
prevents article overlapping. 
With the HTS500, the user can also keep open more jobs at the same time. The list of the open 
jobs can be displayed in the field named Jobs. You can pass from one job to another by 
selecting it from the list.  
 

4.1.1 Mono-article job 
 
Selecting the “New Job” option of type Mono-article job  from the File menu or pressing the 
pushbutton/icon, it is activated a new job creation window. It shows on the left side a list of the 
available Families (as from ABB catalogue) and on the right side a list of the articles belonging 
to the selected Family. To select a Family it is necessary to click with the mouse on the Family 
name. 
To notice that you can display just the Cables items, just the Pins items or both, only using the 
control boxes up on the list. This functionality allows you to limit the articles displayed, making 
easier the research of what you want to utilize. Once selected the article you that you want to 
work on, it will be sufficient a double click with the mouse on the name or a single click on the 
OK pushbutton to create the new job. 
After a short processing the programme shows, in the layout area, the new job created of a 
plate on which are positioned as many articles as they can be associated.  
 
4.2 - How to write on the tags 
 
To insert the markers on the tags, HTS500 uses the Properties window and displays the 
insertion results directly on the layout. Because the Zoom level of the job area can be such that 
what is inserted in the tag cannot be well read, the tag with its contents is displayed in the 
Properties window.  
First of all you have to select the tag you want to write on (the selected tag is highlighted in 
Green on the layout), then enter the text into the Properties window.  
If you wish to insert the same marker on more tags, just select the relevant tags (by using Ctrl 
and/or Shift keys in combination with the mouse) and enter the text and the eventual settings 
into the Properties window. The settings and the text will be inserted into all selected tags.  
To insert the text on more lines it must be used the Ctrl + Enter keys for a new line. 
 
Also the Copy and Paste options, available on the tool bar and in the Edit Menu, can be used to duplicate the 
markers.  
 
For further information looks in the chapter relative the Properties window.  
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5 – Tools available for the management of articles 

 
5.1 - Management of Custom articles  
    
The programme allows the creation of customized Articles starting from basic system articles 
by using a graphic editor. 
These articles can be grouped into Families all depending from the start CUSTOM family. 
The customization of an article consists in creating sub-partitions that are called “fields” to 
which can be assigned various properties. 
Let’s see which are the necessary steps for the creating and the personalising of a Custom 
Article. 
From the "Tool " menu the item “Customize Article” is selected.  
The window shows a list of the articles split into families (as from ABB catalogue). 
To notice that is possible, to reduce the amount of the displayed articles and consequently the 
selected ones, marks the control boxes for Cables and/ or Pins Items.  
After having select the basic article that you wish to customize (by double clicking or pressing 
"OK"), you access to the Article Customization Window that is the real editor. 
 
Once the customization is ended, pressing the "Close"  button on the Tool Bar, it is requested 
to save the customized article. It is asked to assign a new code for the article and a Family 
name in which memorize it. You can create new families at your pleasure with the “Create 
New” button.  
Note the flag on the voice "Job started with this article". Leaving it active a new mono-article 
job will be opened utilizing the article just customized.  
It is also possible to enter a description for the article. Usually you will use your country’s 
language. The capability to enter this description in more languages it is very useful for multi-
language countries, such as Switzerland and Canada. 
 
 

5.1.1 Article customization window 
 
HTS500 allows to create in a tag writing areas and so it is available a complete graphic editor. 
After choosing the article that you want to customize with the "Customise Article" function in the "Tool" menu, the 
programme shows the Article Customization Window. Note that in the window title will be reported the article code. 
 
We can ideally split this window into areas: 
Tool Bar  
Field size definition area for manual and sequential link  creation  
Layout : area in which the tag is displayed  
Properties window of the inserted field. This window will be different if  the field must contain 
a text  or a picture . 

 
5.1.2 Tool Bar - Article customisation 

 

 
 
Tool bar pushbutton/icon description starting from the left:  
Close : Closes the work session and activates, if necessary, the saving procedure. 
Zoom : (+), (-): Modifies the tag size of 10%. 
Select Fields : Interrupts a possible partitioning session and selects the created fields.  
Create New Fields : Activates the partitioning session. It is the manual field creation  function 
in the tag. After having pressed this button it is possible to draw on the tag the rectangle that 
indicates the field size.  
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Unlocks  all locked fields: if any field was locked, it is unlocked. 
Order  fields numbering: it allows to change the order of the created fields.  
Help : recall the on-line guide. 

 
5.1.3 Manual link creation  

 

 
 
The manual link creation allows to define, with the mouse pointer, areas or fields that will 
contain a text or a picture.  
Pay particular attention  to the number displayed in the "Element no.” field. It indicates the 
number of the tag you are working on.  
To create a new area, press the button on the Tool Bar and position on the tag layout. keeping 
pressed the mouse left key, draw a rectangle with the desired size. Releasing the mouse 
button the start co-ordinates (X and Y – top left corner) and the created area dimensions will be 
memorized. To drag or size a field you can directly work on the layout with the tool "Select 
fields" on the Tool Bar, or modifying the "X" and the "Y" values for the moving and on the 
“Width" and the "Height" values for the sizing.  
It is suggested to define the areas observing the left-right and up-down sequence, because the 
entry order will be the plotting order.  
It is possible in any case to modify later on the field order utilizing the "Order field numbering" button on the Tool 
Bar.  
Notice: Check always that the areas positioned on t he tag, do not overlap.  
For each field or area it is necessary to define the text or picture properties which will have to be contained inside 
it. 
To delete an area after having selected press the “Cancel” button on the keyboard.  
 
Of course exists no limit to a combination of the assisted/manual modality, and with a little of 
exercise you will be able to create links with areas that are arranged in such way to meet any 
requirement. 
 
The "Exit" button activates the saving function for the link just created.  
 
 

5.1.4 Creation of sequential links 
 

 
 
The sequential links creation requires the co-ordinate and area size setting, while the automatic 
creation is up to the procedure.  
Pay particular attention  to the number displayed in the "Element no.” field. It indicates the 
number of the tag you are working on.  
Because the plotter will print respecting the sequence used during the areas creation, It is 
absolutely better, in this step, to adopt the left – right – up – down standard.  
The X and Y fields show the cursor mouse position, that it moves in the strip, providing its co-
ordinates.  
In the Generation box Field the X and Y Origin co-ordinates (top left corner) and the 
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dimensions of the area under creation (width and height) must be indicated.   
The dimensions are important, because the programme allows to create areas with equal or 
multiple dimensions in the width respecting the set values.  
In fact, if the Repeat  field is settled to 1, pressing Create  you will obtain an area with the exact 
dimensions indicated and that will have as origin co-ordinates the ones settled.  
 
 
Once created the first area, the origin co-ordinates will be updated so that they will exactly 
point at the right of the area just created. Pressing Create again you obtain a new area at the 
right of the previous one. And so on for each other press on Create. 
Selecting a Repeat  equal to 2 it will be generated areas with horizontal dimensions twice the 
value settled in the width field.  
You can delete an area selecting it and pressing the “Cancel” button on the keyboard.  
After having done  some selections it is suggested to check the origin co-ordinates before 
going on with the automatic creation of a new area. 
 
The "Exit" button activates the saving function for the just created link. 

 
5.1.5 Element no. - Article customization 

 
The fields or areas created on the element no. 1 are transferred on all the elements forming the 
article.  
So, if you wish to print the same link on all the tags of the print support, the creating area 
operation will have to be executed only on the element no. 1.   
In the case you have to print different links on the same print support, keep in mind that the 
modifications made to one element are transferred to all the elements that come after it . 
 
Example:  Let’s suppose to have a print support with 6 elements. 
Creates a link on the element no. 1. We will find the same link on all the 6 elements of the print 
support.  
Then we modify the element no.  4, using the arrows to pass from one element to another.  
Result : The Elements 1 - 2 - 3 will be the same between them and  the Elements 4 - 5 - 6 will 
be the same between them.  
 

5.1.6 Text properties window - Article customization 
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The settings that can be defined for a field Text type are in the order: 
• lining up horizontally  (left, centre, right) 
• lining up vertically (top, centre, bottom) 
• vertical writing. If selected the text entered into the created field will be written vertically.  
• automatic character height reduction with minimum height option. When this option is 

activated, if the text exceeds the field size it will self-size, to fit in the field created, until the 
minimum size settled is reached.  

 
• font selection. It is possible to choose among all fonts installed. 
• minimum height (present only if the automatic reduction key is selected) 
 
• character size in points (in the tool tip is reported the height in mm .) 
• character size in width (if 0, it depends on the size of the font set) 
• setting of character colour  
• fixed spacing between vertical lines: it allows setting a fixed vertical spacing value (if 0, it 

depends on the size of the font)  
• fixed distance between characters: it allows setting a fixed horizontal spacing value (if 0, it 

depends on the size of the font) 
• text rotation angle: it allows setting the text rotation angle  
 
• text style (normal, bold, italic, bold/italic) 
• select special symbols: : it allows entering symbols inside the field  
     Notice:  For a correct display the font "ABB"  must be settled 
• Test text or fixed text. In the last case the Modifiable item must be deselected  
 
Finally the following settings can be defined: 
Picture : to enter a picture at the text place.  
Modifiable : if it is flagged it is possible to modify the sub-partition contents in the job; otherwise 

it will remain fixed.  
Locked : once it is flagged the sub-partition cannot be selected anymore with the mouse and 

consequently cannot be moved or modified. To unlock the sub-partitions use the proper tool 
bar button. 

Colour Code : if it is flagged the data entered into the sub-partitions will be transferred on the 
tag following the field positioning order.  

No. of Characters : active only if the Colour Code is flagged. It indicates the maximum number 
of characters that can be entered into the sub-partition. 

Borders : It is possible to assign a border to a sub-partition.  
 

 5.1.7 Picture properties window – Article customisation 
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The picture formats that can be used with the HTS500 are: 
  
• .Gif  
• .Jpg  
• .Jpeg  
• .Bmp  
• .Wmf 
 
Notice:   Remember that only the printer can use all the above listed formats, while the plotter 
prints only the .Wmf format.  
 
When you select the “Picture” option, the programme asks to indicate the file name for the 
picture you want to enter into the tag, or to search it among those that are present in the Hard 
Disk. 
When a file containing a picture is selected, the picture is displayed in the search window; just 
press the "Open" button (or perform a double clicking  on the file name) to enter the picture into 
the field.  
Later you can change the picture pressing the Browse button.  
The user has the possibility to: 
• move the picture within the field for a more accurate centring operating on the "Left" and 

the "Top" values. In particular, if you increase the "Left" border value, the picture will move 
to the right, while if you decrease it (negative values are also accepted), it will move to the 
left. In the same way, if you increase the "Top" border value, the picture will move to the 
bottom and if you decrease it, it will move to the top.  

• modify the picture size  according to the width and the height (operating on "Width" and 
"Height" values). 

• Lock the picture size to the sub-partition field. In this case the picture will be deformed to fill 
up the field.  

• Rotate the picture horizontally.  
• Rotate the picture vertically. 
• Lock the field preventing the sub-partition moving in the tag.  
• Define the field as modifiable or non-modifiable. If it shows the flag mark, you can, during 

the working step, change the picture file or turn the picture field into a Text field. If it does 
not show the flag mark, the field contents will be fixed.  

Notice: if you select "Text" again, the picture is deleted , and you go back to the typical text 
settings.  
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5.2 - Customize Strip Function 
 
HTS500 allows to define a series of fields in a fast and graphic way. This function it is very 
useful in particular for the stripes management. 
After having create a new job with a base article (for example from the Stripes Family) from the 
HTS500 principal window you can enter in the window link definition. Select with the mouse the 
first article, from the tool Menu, the Customize item voice or pressing the Ctrl – A (Control 
button together with the A button) the management window will be activated. 
• Width Module: It allows to set the fixed module width in mm. 
• Horizontal/Vertical: It allows to define the links creation direction. 
• Heading Management: It allows to define a heading stripe for the article. 
 
Vertical links management: 
• Modules Number: It allows to define how many multiply of the single module can fit in the 
link. 
• Text:  It allows to write the text correspondent to the number of the previous modules. To 
write on more lines press the Control  + Enter  buttons together. 
• OK:  confirm. The inserted values will be displayed on the lay-out with the links. 
• Cancel:  It will not register the inserted values. 
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6 – Print-outs 

 
6.1 - Print Job 
 

Print options 
 
HTS500 manages the print queues, so the print function it is split in two successive steps: print 
queue preparation and print queue execution 
 
To activate the print function, choose from the "File" menu the voice “Print Job” or press the 
corresponding button on the tool bar.    
 

 
 
The print preparation window is divided in two parts. 
The first allows to define the print type and it is possible to choose among the following options: 
• Print all:  it is the whole print of the job  
• Pages: it allows the plate(s) selection  

It is possible to select the Page/plate start and end. 
 

Notice:  In the HTS500 terminology the term "Page" is used to identify both the plotter “plate” 
and the laser printer “sheet” in case of jobs with laser printer articles. 

 
• Selected matrices: allows printing the selected matrices  
• Selected tags:  allows printing the selected tags 
 
The second allows to define the following settings:  
• Start matrix 
• Start tag 
• Number of repetitions  
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According to the selected setting type, the following options can be either activated or 
inactivated:  
 
• Reference only if  it changes 
• Progressive numbering 
• Compact : the programme does not print the blank tags  
• Group the tags  
• Print only the select fields: It prints the selected fields defined with the customize item 

option. 
• Print empty tags:  It prints the tags even if they are blank. 
• Headings management:  It prints on the tags skipping in a different item if the heading 

value inserted in the data generation will change. 
 
Change item:  at print stage is possible to select a different article from which the job was 
created. This button open the article selection window. 
 
After having define the settings, press the "OK" button to go on with the print.  
After a short processing, the print queue management window appears.   
 
The print just prepared is added to the print queue list. To notice that the name of the job from 
which  the print was generated is displayed with the indication of the pages number of the print.   

 
Print all  

 
This option allows to print the whole current job.  
In the case of a job create with more pages, it is created a print queue file for each page.  
 
Let’s see in detail the settings: 
• "Start matrix": it is disabled 
• "Start tag": it is disabled 
• "Number of repetitions": it allows to repeat the whole print for a number of times  
• "Reference only if it changes": it prints the tag references only when they changes  
• "Progressive numbering": it prints the progressive numbering of the matrices which contain 

data to be printed  
• "Compact": it is disabled 
• "Collate the pages": it is activated when a repeat number greater than one is selected and 

operates in case of a multi-page job  
Example. If the job is made of three pages and the repeat number is set at two, the following 
print sequence will be obtained:  

 Page 1, Page 2, Page 3, Page 1, Page 2, Page 3  
      if the item "Collate the pages" is not selected;  
 Page 1, Page 1, Page 2, Page 2, Page 3, Page 3  
      if the item "Collate the pages" is selected. 
• “Print selected fields only”: it is disabled 
• “Print empty tags”: it is disabled 
• “Heading Management”: it is disabled 

 
Pages 

 
This option allows to print a page selection of the current job.  
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In the case the job is create with more pages, the start and the end print page can be selected. 
The selection is performed on the “from” and the “to” boxes by writing the page number or 
using the mouse on the sides arrows box.  
 
Let’s see in detail the settings: 
• "Start matrices": it is disabled  
• "Start tag": it is disabled 
• "Number of repetitions": it allows to repeat the print of the selected pages for a number of 

times  
• "Reference only if it changes ": it prints the tag references only when they changes  
• "Progressive numbering": it prints the progressive numbering of the matrices which contain 

data to be printed  
• "Compact": it is disabled  
• "Collate the pages": it is activated when a repeat number greater than one is selected and 

operates in case of a multi-page selection 
Example. If the print selection is made of three pages and the repeat number is set at two, the 
following print sequence will be obtained:  

 Page 1, Page 2, Page 3, Page 1, Page 2, Page 3  
      if the item "Collate the pages" is not selected;  
 Page 1, Page 1, Page 2, Page 2, Page 3, Page 3  
      if the item "Collate the pages" is selected. 
• “Print selected fields only”: it is disabled 
• “Print empty tags”: it is disabled 
• “Heading Management”: it is disabled 

 
Selected matrices 

 
This option allows to print a matrix selection of the current job.  
 
To select the whole matrix it is sufficient to select one element (head, tag, reference) of the 
matrix with the mouse.  It is possible to select the matrices of more tags.  
 
Let’s see in detail the settings: 
• "Start matrix": it allows to define a matrix print position that is different from the selected 

position 
• "Start tag": it is disabled 
• "Number of repetitions": it allows to repeat the print of the selected matrices for a number of 

times  
• "Reference only if it changes ": it prints the tag references only when they changes  
• "Progressive numbering": it prints the progressive numbering of the matrices containing data 

to be printed  
• "Compact": it allows to print the selected matrices one near to the other without leaving any 

empty matrices in the page 
• "Collate the  matrices": it is activated when a repeat number greater than one is selected and 

operates in case a number of matrices exceeding one was selected  
Example. If the print selection is made of three matrices and the repeat number is set at two, 
the following print sequence will be obtained:  

 Matrix 1, Matrix 2, Matrix 3, Matrix 1, Matrix 2, Matrix 3  
      if the item "Collate the matrices" is not selected;  
 Matrix 1, Matrix 1, Matrix 2, Matrix 2, Matrix 3, Matrix 3  
      if the item "Collate the matrices" is selected. 
• “Print selected fields only”:it is disabled 
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• “Print empty tags”: it is disabled 
• “Heading Management”: it is disabled 
 

Selected tags 
 
This option allows printing a tag selection of the current job.  
 
• “Select all”: this button allow the user to select all the tags positioned on the plotter plate 

directly in this window, without to go back to the job window. 
 
About the modality tags selection look at the above chapter “Select”. 
 
Let’s see in detail the settings: 
• "Start matrix": it allows to define a matrix print position that is different from the selected 

position 
• "Start tag": it allows to define in the start matrix selected the start tag position from which the 

print has to start 
• "Reference only if it changes ": it prints the tag references only when they changes  
• "Progressive numbering": it prints the progressive numbering of the matrices containing data 

to be printed  
• "Compact": it allows to print the selected tags one near to the other without leaving any 

empty tags in the matrix 
• "Collate the tags": it is activated when a repeat number greater than one is selected and 

operates in case of number of tags exceeding one was selected  
Example. If the print selection is made of three tags and the repeat number is set at two, the 
following print sequence will be obtained:  

 Tag 1, Tag 2, Tag 3, Tag 1, Tag 2, Tag 3  
      if the item "Collate the tags" is not selected;  
 Tag 1, Tag 1, Tag 2, Tag 2, Tag 3, Tag 3  
      if the item "Collate the tags" is selected. 
• “Print selected fields only”: it allows to print only the selected fields of a customized article. 

For example it is possible to select and print only a stripe part. 
• “Print empty tags”: it allows to print an article that contains an image (logo) even if this article 
doesn’t contain texts. 
• “Heading Management”: the software allows to manage the change article when the heading 
inserted by the user will change. 
 
6.2 - Print queue 
 
An innovation introduced with the HTS500 is the print management using the Print Queue.  
 
The prints, prepared with the “Print job” function, are transferred to the “Print queue” for the real 
print and a list of all prints performed is shown in the Print Queue window. 
 
Because the prints are memorized, it is possible to perform again a job print just choosing it on 
the list.  
 
From the “File” menu with the “Show print queue” function or using the button in the tool bar, 
you can access the Print Queue Window.  
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On the left side there is a list of printed jobs or of jobs ready to be printed.  
 
The already printed jobs are marked with a Green light, the jobs (all or partially) not yet printed 
are marked with a Red light. 
  
When a Print Queue is selected (using the mouse), in the screen area above the list, the 
following information are displayed: 
Job : name of the job from which the print has been extracted  
Articles : list of articles that are used in the job   
Plate : marker of the plate to be used for the print  
 
In the list, beside the job name , is reported the number of pages   of which the print is 
composed. It is possible to have in detail the pages of a job pressing the symbol “+” with the 
mouse, while to collate the job pages press the symbol “-” with the mouse.  
 
On the right side, there is a set of buttons that allow to manage the Print Queues and in 
particular:  
 
The Multiplotter management allows the user to address the selected print queue to one of the 
settled printers. On the right of the window are shows the buttons with the descriptions of the 
associated printers. To address the selected print queue just click on the button of the desired 
plotter. 
 
"Delete ": it allows to delete the selected print queue.  
"Delete all ": it allows to delete all the existing print queues.  
 

Preview Print 
 
The Preview Print  function shows on the screen how the job print will be after the settings. 
For example if it utilized the Number of repetition option and  from the Matrix nn. You can see 
really the print start position and where the repeated tags will be printed. 
 
The preview print allows to print the whole job in any printer to verify the content. 
 
For example it is possible to print a job in a Laser print before to print it on the HTP500 Printer.  
 
The automatic option of sheet reducing allows to reduce the print job dimensions to the 
selected printer sheet dimensions.  
 
 
 
 
 
  



ABB France  

Division Produits Automation 
Département Export 
10, rue Ampère Z.I. - B.P. 114 
F-69685 Chassieu cedex / France 
Tel. : +33 (0)4 7222 1722 
Fax : +33 (0)4 7222 1935 

As part of its on-going product improvement, ABB 
reserves the right to modify the characteristics or 
the products described in this document. 
The information given is not-contractual. For further 
details please contact the ABB company marketing 
these products in your country. 
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